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Welcome to Lambslist 2.0

This manual should provide all the information you need to setup and operate you Lambslist Child Check-In 
System. 

Introduction
 
Lambslist has been broken into four main categories:  Registration, Maintenance, Reports and Setup.  Each 
category can be viewed at the top of most screens within Lambslist.  By holding your mouse pointer over any 
of these titles you will see a complete listing of the subtopics under each category.  These topics will be cov-
ered in detail after an introduction to some key terms and concepts. 

         Figure 1

Key Concepts and Terms

Please read through and become familiar with the following terms.  These terms will be referenced throughout 
the entire document.

Database Terms

Families – The lambslist database keeps a master record for each family. This data includes basic contact 
information, pluse data pertinent to the check-in process. 

Children – Each family can have an unlimited number of children added to the database.  Child records         
include, but not limited to, birthday, grade level, and allergies or comments for each child.    Note: A child     

record cannot exist separate from a family record.

Services – Each of the standard meeting times for your church must be named and entered into the database, 
examples could be Sunday 1st, Sunday 2nd, Sunday PM, and Wednesday.  The names of each service along 
with the day of the week and time of day of the service will also need to be entered into the system. 

Rooms – In order to use lambslist, each of the children’s rooms in your facility must be named.  The names 
of each room will be entered into the lambslist database along with the grade or age level of the children            
allowed in this room, as well as the room capacity.  In addition, the services that a room is available for must be         
selected.
 
Users – Users refer to church or volunteer staff that will be using the program.  Users can each have their 
own user name and password to login to lambslist. Lambslist allows for two types of users:  Administrators 
and Agents.   Administrators can view all of the data and programs, while Agents can only check children into 
classes and run classroom attendance reports.
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Misc Terms
 
Self Check-in – Parents are able to access and check their own children into a room, from an unattended 
station. The family information can be accessed either by using a barcode system, or by the parents typing in 
their 7-digit phone number. 

Volunteer Assisted Check-in – In this mode children’s ministry volunteers operate the check-in process, and 
are able to choose from four different types of searches to locate and check-in families and individuals.
 
Promotion – Lambslist includes a feature allowing administrators to promote/move every child in their system 
to the next “Level/Classroom.”   The two obvious promotion times are on a child’s birthday or during the sum-
mer for grade-based classrooms.   See the “Promotion” section for details (pg.20).

Parent and Child Labels – These are self-adhesive name tags printed by the Dymo printer when a child is 
checked into their class.  Parent and child labels with matching random security codes are generated at the 
time of check-in.  For label customization see (Setup|Labels, pg.24).

Menu Category Terms
 
Registration/Check-in – Registration/Check-in is the process of recording a child’s attendance into the system 
and printing a child and parent security label.  There are several methods to locate the child in the lambslist 
system for check-in.  However, once the child’s records are located, the registration process is the same.  (See 
various check-in methods, pg. 16).

Maintenance  – As this name suggests, this area provides the administrator access to the functions necessary 
to maintain the organization’s database, including editing child and family records and merging families, etc. 

Reports – This menu allows the user to run the reports on the organization’s data.

Setup – Allows the administrator to setup all of the key elements of lambslist, including: Rooms, Services, Us-
ers, iPad Printing, Labels, Contact Templates, and Promotion Schemes. It also provides the access to our Help 
screen to access FAQs and Printer Assistance, as well as a variety of Free Resources.
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Getting Started

In this section you will learn how to start with a new lambslist account and setup everything you need to start 
adding families and checking in kids.

Step 1 – Setup Users

Hold your mouse over the “Setup” menu title until the drop-down menu appears.  When the menu appears, 
move your mouse pointer down to “Users” and then left click, you will be taken to the following screen. 

You will see that there is already one user in your system. This will be the e-mail address that you used to login 
to lambslist the fi rst time.  

Adding a User:  To add a user, simply click the “Add User” button as seen in Figure 2. 
 

       Figure 2

After selecting “Add User”, populate the requested fi elds shown in Figure 3.

      Figure 3
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Step 2 – Setup Services

Hold your mouse over the “Setup” menu title (left-hand side of window) until the drop-down menu appears.  
When the menu appears, move your mouse pointer down to “Services” and then left click, you will be taken to 
the following screen (Figure 4).

     Figure 4

Once on the Service Confi guration screen, click on the ‘Add Service’ button and begin to create services based 
upon your organizations needs. When setting up a service you will need to do the following:

 1. Give your service a name
 2. Choose the day of the week the service will occur.
 3. Insert a start time and end time*
 4. Designate a lead time and lag time. 

* The end time does not activate or deactivate a service, but is utilized when the Multi-Service check-in is 
activated. The service is activated based upon the day of the week, the start time, and the lead time. The lag 
time determines when the service will deactivate. 

For example: If you set up a service for Sunday, with a start time of 9:00 AM, and a lead time and lag time of 
30 minutes each, then you would be able to start checking children into the service on Sunday at 8:30 AM, and 
continue checking them in until 9:30 AM, at which point the service would automatically turn off. 
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Edit Existing Service: To make changes to any service, click on “Edit” to the right of the name.  Edit “Service” 
screen is shone below (Figure 5).
 

     Figure 5

Field Explanations of Figure 5:

“Check-In Lead and Lag Time” – In the real world we know that church members don’t always show up to 
church on time.  In addition, we realize that volunteers and other staff may need to check-in their kids much 
earlier than regular members.  For this reason we have developed a “lead and lag time” to surround your 
service time.  Entering a “30” in the lead time fi eld will cause the service to go “active 30 minutes before the 
service start time.  Entering a 30 in the lag time would cause the service to stay “active” 30 minutes after the 
service has started.  Note:  Kids may only be checked in when services are active.

State of this Service – Services can be set at “Visible”, meaning they will activate on the day and at the time 
specifi ed, or they can also be set as “Invisible”, meaning the service is hidden and will not activate. Services 
marked as “Invisible” can be changed back to visible by selecting “Show hidden or inactive records” on the 
Preferences screen, then edit the service. 
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Multi-Service Check-in 

Multi-Service check-in is designed to allow parents to check their children into multiple services during their 
initial visit to a check-in station. This option will be activated on the Preference screen, under the General 
section. Once activated you will need to review your service and room confi guration, based upon the fol-
lowing criteria, to ensure multiple services will be available.

 1. Consecutive services will need to have the second, or in some cases third, service be scheduled  
   within 75 minutes of the END time of the previous service.

 2. Review room confi guration to ensure the correct rooms are available for their respective services,  
   and that the correct number of labels to print are chosen.

 3. Once completed you are ready to check-in.

Checking in Using Multi-Service:
 
 1. Regardless if you are using Self Check-in, or one of the volunteer-based check-in options, you  
  will need to fi rst to access a family’s account
 
 2. Once you have the family screen up, you can choose to either check the children in individually  
  (3a), or by using the checkin all option (3b). 

 3a. If you check the children in individually, a pop-up box will appear with the service options listed,
  choose the appropriate service option. At this point, a second pop-up box will appear   
  requesting you to choose the appropriate classes for each service. After choosing the    
  correct classes, click the check-in button and the child will be checked in and a label printed.

 3b. If you are using the Checkin All feature, once you click on the ‘Checkin All’ button, a pop-up box  
  will appear with the service options listed, choose the appropriate option and the children  
  will be checked into the rooms their history shows them having been checked into in the   
  past. (Note:Checkin all is designed for check-in speed and does not allow for room changes)

Using Multi-Service with Multi-Campuses:

 1. Go to the Service Confi guration screen and click on the boxes associated with the services you 
  want to have available to check children into.
 
 2. Click on ‘Activate’ for the fi rst service, and follow the above directions for checking children in. 

 3. Once your fi rst service is fi nished you will need to make alterations to the Service Confi gurations
  in order to activate the subsequent services.

Using Multi-Campus to Select a Service:

 1. On the Preferences Screen, mark the box for ‘Manual Service Selection’. Click Save
 2. Go to the Service Confi guration screen.
 3. Click ‘Activate’ for the service you want active on that specifi c computer
 4. Proceed to check children in. 
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Step 3 – Setup Rooms

Hold your mouse over the “Setup” menu title (left-hand side of the window) until the drop-down menu appears.  
When the menu appears, move your mouse pointer down to “Rooms” and then left click, you will be taken to 
the following screen.

     Figure 6

 

Adding a Room: To add a room, simply click the “Add Room” button.                     The following screen will 
appear. Enter the information for the fi elds requested, set up the promotion type, and select the services this 
room will be available for. 
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Field Explanations:

Room Name – The Room Name is a unique name to this room since it will be seen on all reports.

Capacity – This is the maximum number of kids available to be served in this classroom.  Kids can 
be checked in beyond this maximum number; however, the room capacity will only be used for report-
ing purposes.

Status – Active or Inactive.  Marking a room as inactive is similar to deleting the room.

Print Label – If this box is checked, then labels will print when a child is checked into this room. You 
also have the option to choose how many labels will print. 

Optional Label Output - This feature allows you to choose the number of labels to be printed out for 
any child being checked into a specifi c room. (See pg. 11)

Promotion Type – Use this drop-down box to defi ne the type of promotion scheme associated with 
this room.  For example, age suggests the room qualifi cation is age-based; and grade suggests the 
room qualifi cation is grade-based. (See the promotion system section of this manual for more details 
about promotion.)

Min/Max Age/Grade – This number represents the minimum and maximum age or grade (depending 
on promotion type) that will be allowed in this room.  For example, if the promotion type is set to age 
and this room is for three-year-olds only; you would set the minimum to three and the maximum to 
three.

Select Services – All of the services set up in the previous step should be shown in this list.   Select 
all of the services in which this room will be open for kids to check in.

Save – You must click this button to save any changes you have made to this screen.
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Step 3 – Setup Rooms (continued)

Optional Label Output Instructions

The Optional Label Output feature is designed to provide organizatons who desire to print additional 
child labels the ability to set up each room with the number of labels needed. This feature will allow 
upto four (4) child labels to be printed when checking in, althought the default is set to print only one 
child label per room. To adjust the number of labels printing for a room follow these steps:

 1. Goto your Room Confi guration screen

 2. Click on the room you would like to adjust.

 3. Choose the number of labels you would like to print from the drop-down option on the   
 lower left column. 

 4. Once you have chosen the number of labels you would like to print, click ‘Save’.

Editing a Room

Edit Existing Room: To make changes to any room click on “Edit” to the right of the name.  When editing a 
room, the following screen will be displayed (Figure 7).

 (fi g. 7)



Step 4 – Adding Families

The “Add Family” screen can be reached from different locations within lambslist.  

The two options are: 
1. Maintenance –> Search, then “Add New Family.”  
2. Registration –> Family Check-in -> Add to Existing Family or Create a New Family.

The following screen will appear when you select “Create New Family & Child” (Figure 8).

       Figure 8

Field Explanations of Figure 8:

Phone Numbers  – Field will be searched from the phone number look-up screen.  Enter the 10-digit primary 
phone number with no dashes (i.e. 9182584839). You are able to input additional numbers. 

Bar Code – Field will be searched when a bar code is entered in the phone/bar code screen.

SMS Text Messaging - To utilize the SMS Texting option, enter in a mobile number, click on the permission
box, and supply the parent(s) cell carrier. After the information is saved, the next time you access the ‘edit
info’ box you will see an option to Send SMS Text.
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On the “Create New Family & Child” screen, enter the child data under the “Child Info” section (Figure 9). 
To add a child to an existing family, simply “Search” for the family name under “Maintenance” on the header.  
Once the family is found and selected, click on the “Add Child” Button.

         Figure 9

Field Explanations of Figure 9:

Special Needs – If checked, it will remove the child from the promotion scheme, allowing the child to be
manually checked in to any room. 

Worker/Volunteer – If checked, this record will be removed from the promotion logic. Workers will only receive 
a name badge, the parent label will not print for those with this option selected.

Development Lock - If checked, the child will be able to check-in to any Development Based room.

Bar Code ID – This fi eld is used to assign a bar code to an individual child record.  For additional detail, please 
refer to the “Bar Code Check-in” section. (See pg. 16)
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Step 5 – Editing Family & Children Information

To edit a family or child, you can reach the needed screen by following the steps below:  

Registration –> Family Check-in -> Select Family by Last Initial -> Select Families Last Name.

Once you have selected the desired last name, the following screen will appear:

      

Editing a Family:  

Click on the Families Last Name. (As seen in the picture above) 

A drop down menu will appear. (See picture below) 

Select “edit info.”  

Enter desired info and click “Save”.

•

1.

2.

3.

4.
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Editing a Child:  

Click on the Child’s Name. (See fi rst picture below) 

A drop down menu will appear. (See second picture below) 

Select “edit info.”  

Enter desired info and click “Save”.

1.

2.

3.

4.
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Registration

The main function of lambslist is to produce security name tags for children and parents while recording the at-
tendance of each child in their respective classrooms and services.   
 
The registration process is broken into two very simple parts:

1.  Find the family

2.  Check-in children

(In order to accommodate as many different types of check-in preferences as possible, lambslist provides sev-
eral different screens for the purpose of looking up families. Also, you will often see children highlighted with a 
color when checking them in. For a color description please see FAQ, pg.30)

Volunteer-Assisted Check-In Options
 
Family Check-in – From this screen your volunteer will locate the family either by asking for their last name                 

            , their phone number        , a partial name or number  , or by individual        .

Once the family, or individual, information has been located in Lambslist, a list of all of the kids associated with 

that family will be shown.  Simply click on the icon  next to each child or select the “check in all” button to 
check in all the children.

Self Check-in

This mode is intended for a kiosk-type operation, when parents are checking their children in themselves.  

There are two options for looking children up using self check-in: by 7-digit phone number, or bar code 
scanner. Regardless of the type chosen, regular menu items will be hidden from the user for security 
purposes.

Self Check-in (via phone number) – Parent enters their 7-digit phone number and clicks fi nd, the screen 
should now display the family check-in screen. Once the family has been located in the system, the check-in 
process will be the same as volunteer-based check-in. To exit the Self Check-in mode, click on the ‘exit kiosk
mode’ in the upper right-hand corner, then enter a username and password when prompted. 

Bar Code Check-in

Family - From either the volunteer-based “family check-in” phone screen or the “Self check/phone” screens, a 
bar code can be scanned to look up a family.   When the family bar code is found in Lambslist, a list of 
associated children will be displayed on the check-in screen. 

Teen - If the bar code starts with a “T,” the system will look at the “child record” bar code rather than the fam-
ily record bar code.  When found, the system will check-in the child automatically and print a name tag without 
any on-screen interaction. In these situations no parent tag will be issued. This feature is intended to be used 
by teens/children checking themselves into a class.

Multi-Service Check-In

See p.9
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Maintenance 

This area is intended to allow administrators quick access to a few key database cleanup and bulk edit func-
tions, as well as to easily locate and edit individual records without going through the registration interface.

Families 

In this section the administrator can bulk edit these key database elements.

 

Children’s Grade Assignments – A listing of every child in the system or every child in a particular room can 
be retrieved and shown in a spreadsheet-like format for bulk editing.  Use this screen to assign grades,
and unique IDs or barcodes to individual children, or birthdays.

Add Bar Codes for Families – This screen shows a listing of all families in the system with their primary 
phone number and bar code.  Use this screen to quickly assign bar codes, for self-checkin, to every family in 
your system.

Add Bar Codes for Teenagers – If the bar code starts with a “T,” the system will look at the “child record” bar 
code rather than the family record bar code.  This feature is best used with children who check themselves 
into youth group or adults checking into a small group and you want a name tag printed for each student.  After 
scanning, if a “T” is found, the system will check-in the teen automatically and print a name tag without any on-
screen interaction.

Merge/Move Adopt Child into Different Family - This screen is mostly intended to assist administrators
moving children from one family to another, or to combine families.  Follow the on-screen instructions to merge 
families.

Contacting Families in mass - Allowing you to contact all the families listed in your Lambslist account via e-
mail or SMS text messaging. Click on the option you would like to use, add your message, and send. 
(Permission boxes found in the family information must be marked and mobile information listed in order to use 
the SMS texting feature.) 

17



Search

Using this screen the administrator can locate any family and edit both the child and family records.  Type in 
any or all of the following to limit the search:  Child’s First Name, Family Last Name, or Primary Family Phone. 

 

This is different between fi nding the family here instead of through the registration system is that there is not a 
way to check kids into a service from this screen.
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Reports

There are currently eleven reports available in lambslist.  These reports are designed to help you analyze 
the attendance records you have collected by checking kids into classes.  On many of these reports you may 
choose “export to .csv” to download the data from the report to your local computer to be opened by a program 
like Microsoft Excel.

Report Descriptions

Following is a list of the nine reports and a brief description.

Today’s Class – Provides a quick list of every child currently checked into a classroom, and offers and room-
by-room breakdown of the children checked in, as well as a emergency fi re drill report, in PDF format.

Attendance – This report allows you to see each classroom with the attendance for that classroom and a 
percentage capacity given a date range.  From this report you can also click on the classroom name to see a 
classroom breakdown by service, and then click on the service name to see a service breakdown by child’s 
name.

Rooms – By selecting a classroom and date, all the kids checked into that room on that date could be viewed.

Room Rosters - Allows the user to select a room, then displays all the children within the account that qualify 
for the room, based upon its set-up parameters. This report also will provide the ability to communicate indi-
vidually with the child/parent, or contact the entire room/group via mail, e-mail, or SMS text messaging. 

Lost Sheep – This report is designed to help locate people who have stopped attending.  Typically this report 
would be given to pastoral care for follow-up. This report will also provide the ability to print a mailing label (or 
all the labels), send e-mails, and send SMS text messages to wish children/families a special message.

History – Allows you to see all of the attendance records for a child matching the search criteria (either fi rst 
name and/or last name).  This is useful if you want to track the attendance of a particular child.

Children - This report will provide the number of individual children that were checked in during a specifi c date 
range. 

Birthdays – Generates a listing of all the kids in the database who have a birthday in a given month and/or in 
a specifi ed room.  This report will also provide the ability to print a mailing label (or all the labels), send e-mails, 
and send SMS text messages to wish children a special message.

Visitors – Shows a listing of all visitors (User sets date to track as far back as Lambslist start date).  Results 
can be limited by selecting an individual room. This report will also provide the ability to print a mailing label (or 
all the labels), send e-mails, and send SMS text messages to wish children a special message.

Stats – A quick snapshot of your organization including services, rooms, people, users and attendance.

Export – Allows you to export all of your attendance, family, or kids records to .cvs (Excel) format.

Individual and Group Communication

Individual and Group communication is available through four of the reports provided. Birthdays, Visitors, Lost 
Sheep, and Room Rosters provide the ability to contact parents/guardians via e-mail and SMS text. This can 
be done on an individual basis by clicking on “E-mail” or “SMS” in the contact column, or as a group by 
selecting “E-mail All” or “SMS All” at the top of the page. 
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Set Up (Confi guration)

This section discusses how to confi gure services and rooms, as well as a variety of preferences available for 
the check-in system. The tab also offers a ‘Help’ option for any issues that arise, and the ability to promote 
children in grade-based rooms.  Please review the promotion types and promotion terms below.

Promotion Explained

Every church has a sequence in which kids move through the children’s ministry.   When children move from 
one room to another, the database needs to be updated to refl ect this change.  It is possible to make this 
change manually for children as they check in at the volunteer-based check-in stations.  However, this can be 
very tedious for large churches and it is not an option in a self check-in environment.    To overcome this prob-
lem, lambslist developers have devised an automatic promotion system to take care of most but not all of the 
transitions in your children’s department. (Please note that you do not have to use this feature to use Lamb-

slist.  You can manually promote kids. If you prefer to manually promote the children, go to the 

“Preferences” tab and un-select the “Enable Smart Rooms” option.)

To understand the automatic promotion we must fi rst understand how and why kids are typically promoted and 
to defi ne terms about each type.  Please read this section thoroughly to understand automatic promo-

tion.

In a typical church there are at least two and sometimes three types of promotion schemes happening simul-
taneously in the children’s department.  We have defi ned these types of promotions and allowed you to assign 
each room to a particular promotion type.

Development-Based Promotion – Typically used in the nursery and toddler rooms where promotion occurs 
when a child learns to crawl, walk, talk, or a combination of the three. This can also be used with other 
developmental stages children proceed through (ie. potty-training). If a child will be attending a Development 
Based class, they will need to have the “Dev Lock” selected for that child within their individual account. Within 
these rooms children will be advanced manually.

Age-Based Promotion – Promotion occurs based on a child’s age.  For example, a child turning 4 moves to 
the 4- and 5-year-old classroom from the 2- and 3-year-old classroom on their birthday.

Grade-Based Promotion – Children move from one room to another based on the grade assigned to them.  
Example, A child moves from 3rd to 4th grade.  This typically occurs in mass affecting the 1st through 6th 
grade classroom.

Not Promotable – This room type will not be affected by the promotion process.  This category was added to 
allow churches to perform special check-ins; for example, labeling a room entitled “Volunteer” and check-in 
volunteers.
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How It Works

Each room in the system is assigned to one of the promotion types.  In addition, for age- and grade-based 
rooms the minimum and maximum age/grade will need to be specifi ed for each room.  All rooms will then need 
to be placed in the order of their promotion.   The following logic will then be applied to each room type.

Development-Based Rooms – Admin volunteers must manually promote these children dependent upon their 
development in certain areas. 

Age-Based Rooms – When a child has a birthday the system will automatically increment the child’s age by 
one year.  It will then look at your promotion sequence to see if the child’s new age moves them to the next 
room or not.  If it does, then the next time the child is checked in they will check-in to the new room.

Grade-Based Promotion – Under “Setup –> Promotion” there is a link titled “Promote all grade-based chil-
dren.”  Clicking this link will take children who have a grade entered in their record and increment that grade 
by one.  It will then search your promotion setup to see if the child’s new grade moves them to a new room.  If 
it does, the next time the child checks in, they will automatically be assigned to their new room. If the child’s 
promotion grade exceeds those available, the child will be listed as “Graduated”, and will be deactivated.

What About Special Needs Kids?  If you have a developmentally-challenged child that needs to stay in the 
5-year-old room; for example, no matter how old they get, simply click the “special needs” check box on the 
child’s record and the promotion program will ignore this child.  Note: With this option, you can, at all 

services, move any child to any room manually.

Promotion Editing

Under “Setup –> Rooms” there is a “Promotion Setup” Button.      

You will see the following screen as shown in Figure 10.

 
           Figure 10

To edit your promotion sequence, simply type in the sequence number for each room, and then choose the de-
velopment type and the grade/age minimum and maximum for that room.  As you can see from the on-screen 
note in fi gure 10, moving off of each fi eld will save the data that you typed into that fi eld.  
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Promotion Control Center

The promotion control center can be reached from “Set Up –> Promotion.”  This screen is used to promote 
grade-based children.

Clicking “Promote All Grade-Based Children” will cause each child’s record, that has a grade assigned, to 
increment that grade level by one.  It will then search through all the rooms and match each child to the appro-
priate room based on their new grade.

Recent Promotions

This section will display any promotion initiated, along with the date and time the promotion took place. You 
also are able to download this data into a csv fi le, showing each child’s new and previous grades. In addition, 
just in case a promotion has taken place mistakenly, an ‘Undo’ option is available that will reverse the most 
recent promotion. 
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Preferences

When an administrator wants to sets up the system-wide options, they will need to use the preference screen.  
By clicking Setup –> Preferences, the following screen will be seen:

Descriptions of General Options:

Show Deleted and Inactive Records – When a family, child, room, service or user are placed in an inactive 
status, they are no longer available in your system unless this box is unchecked. When selected, these records 
will reappear.

Track Pager Numbers – If this box is checked, the system allows you to type in a pager number on the volun-
teer-based check-in screen.

Enable Smart Room and Promotion – When checked, Lambslist will automatically attempt to assign the 
correct room to each child’s record based on the child’s age, grade, special needs, etc.

Manual Service Selection – In order to facilitate easy kiosk self check-in, Lambslist automatically selects the 
active service based on the time of day and day of week.  However, if you have a multi-campus church and 
you are using self check-in, you will have multiple services at the same time.  For this reason, we allow you to 
turn off the auto service selection and choose the service manually at each terminal. (See p.8 - Services)

Allow checkin to multiple services - Activating this feature will allow organizations to check children into mul-
tiple services at one time. For this feature to work correctly the previous services end time and the subsequent 
services start time must be within 75 minutes of each other. (See p.8 - Services) 
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Descriptions of Labels Options:

Auto print on Check-in – During the check-in process, if this option is checked under “Preferences”, your 
DYMO printer will automatically start printing when a child/children are checked into a service.

Show Printer Tools – Some reports give you the opportunity to print an address label to send a birthday card, 
visitor welcome letter, etc.  If checked, this will activate the “print” under the “address label” column. 

Only Print Child Labels – If checked, during the checkin process, your DYMO printer will only print the child 
label.  Commonly used with youth groups or adult events that need name tags.

Print only 1 parent label on “Checkin All” -  With this option selected, if a parent/volunteer choose to utilize 
the checkin all feature, instead of one parent label printing for each child, only one parent label will print with 
each of the children and their security codes listed. 

Show label fi eld names for Parent Label - If selected, this feature will print the parent labels identifying what 
each line is. For example, you might see “First Name: Jimmy” instead of seeing “Jimmy”. 

Description of Security Code Options:

Code length - The code length option allows users to choose how long the random security numbers will be. 
Options include 3-, 4-, and 5-digits in length. This will apply when Random codes are chosen, or when Static 
codes are chosen but a unique ID has not been assigned to a child.

Random vs. Static codes - The decision between operating Lambslist using either random or static code 
numbers will depend upon whether organizations prefer for the child/family to have the same security code 
each time they check-in, or have the codes chosen randomly by the computer. If static codes are chosen, a 
unique id will need to be assigned to each child, this can be accomplished through both the Registration and 
Maintenance tabs. (For further instructions see Registration, p. 17, or Maintenance, p. 18).

Numbers to exclude -  Numbers listed in this fi eld will be excluded from those numbers randomly assigned to 
children. Numbers can be manually input into this fi eld, separating each number by a comma with no spaces 
or zeros in front of the numbers, or, if needing to exclude a range of numbers, list the fi rst number in the range 
and the last number separated only by a dash. Please know that 666 and 911 have already been removed.  
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Label Confi guration

When a child is checked in to a class, two labels will print from the Dymo printer.  One label will be used as the 
child’s name tag and the other label will be used as a claim check for the parents. Organizations can easily 
confi gure what prints on each of these labels using the label confi guration screen.

To customize labels, go to “setup –> labels” and the following screen will be shown.

 

For each of the labels there are two columns:  One for “current label” and the other for “available” options.   In 
each of the columns are the names of a variety of database fi elds.  To move a database fi eld from one column 
to the other, simply click on the fi eld name and drag it from one column to the other.  When you are fi nished, 
click on “Save.”  All fi elds in the “Current label” column will print on the label.*

 *Please note: If the “Checkin All” feature is used when checking a child/children into a service, and the 
 “Print only one parent label on “Checkin All” is selected, the only information that will appear on the 
 parent label will the the name/names of the child/children and their security code numbers.
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Contact Templates

The contact templates allow the organization to design a default message to be sent to the parents of children 
that appear on the Birthday, Visitor, and Lost Sheep reports. These messages can be sent via SMS text or 
e-mail from each of the reports. Utilization of the templates will provide users the ability to communicate with 
large numbers of people without having to type out a message to each person, making for more effi cient and 
effective use of time. 

The fi gure below shows an example of a default message that could be sent to recent visitors, from the Visitor 
Report. 

 

Free Resources

Lambslist offers a variety of Free Resources for organizations to use. Included is the Family Information Form 
that can be used to gather and update family accounts, along with ministry applications, background check 
forms, consent forms, and many more. 
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Contact Templates

iPad Printing

Lambslist is capable of checking in children from an iPad or tablet. Printing the labels will require a 
designated computer be connected to a Dymo printer, and the iPad print screen accessed. Instructions are 
included below, and can also be found on the iPad Printing tab.  
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Help

 

Support Links

FAQ - Answers to frequently asked questions can be found online by logging onto your lambslist account, and 
clicking the “FAQ” link under the “Help” tab.

Dymo Printer Help – This section is used to set up your Dymo printer in order to print with Lambslist. A step-
by-step guide is provided based upon the operating system chosen. 

Support Options - Technical support is available via e-mail and phone.  By observing the following support 
courtesies, we can continue to provide affordable check-in solutions.  If you have any questions concerning 
support policies, please see the Policies and Procedures section on pages 29 & 30 of this manual. We appreci-
ate your consideration.

Locate and review the on-line FAQs. Answers to the most often asked questions are located here. 

If you are unable to fi nd a solution, please contact our technical support (Monday - Friday, 8 AM - 4:30 PM 

CST), or submit your question via e-mail at support@lambslist.com.  Customer service will respond as 

promptly as possible to your questions and concerns.  

If you are unable to access Lambslist on the weekend, please contact us by submitting an e-mail to sup-

port@lambslist.com. (Please note: Due to time constraints on the weekend, assistance setting up printers/services/

rooms is available during normal business hours, Monday - Friday, 8 AM - 4:30 PM CST.)

1.

2.

3.
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Lambslist Policies and Procedures

Overview

The following provides Lambslist customers a general understanding of the policies and procedures imple-
mented to ensure consistent customer service, at the highest level of quality.  

Weekend Support

Understanding the nature of the industry and time frame most organizations utilize Lambslist, we offer all our 
customers system weekend support. Our systems are continually monitored to insure 99.9% availability and 
service level agreements. Any issues occurring with the system will be addressed immediately on weekends. 
However, due to time constraints, we do not offer assistance for room/service confi guration, general account 
set-up, or Dymo Printer issues. Our technicians will gladly assist with these issue Monday thru Friday, from 8 
– 4:30 CST.  

Weekday Support

Lambslist technical support is available Monday thru Friday, 8 – 4:30 CST, offering setup/confi guration assis-
tance with the Lambslist software, as well as support with your Dymo printers. We ask that customers need-
ing assistance with their printers fi rst follow the steps provided on the Help screen, under the Set Up tab, and 
attempt to print from both the Dymo software and Lambslist prior to contacting support. Please note that many 
of the issues you may encounter have been addressed on the FAQ screen, customers may want to check here 
prior to calling.  

Non-Payment

When situations arise where a payment is not able to be captured, or a card is declined/stolen, Lambslist will 
attempt to contact the customer on four separate occasions over a two week time period, consisting of two e-
mails and two phone calls. If the contact attempts go without response, at the end of the two week time frame 
the subscription will be terminated, and the customer will receive an invoice refl ecting the cancellation. 

If the organization does not make a reasonable effort to work out payment details within 30 days of the date 
the payment was due, a $100 reactivation fee will be charged and the fi rst months payments will be due, prior 
to reactivation of the account.

Data Uploads

To assist our customers with imputing data into their accounts without having to do so manually, Lambslist 
offers one (1) data upload free of charge. Customers will need to e-mail their data, according to the format pro-
vided in the upload template (found on the FAQ screen), and allow 3-5 business days for completion. 

Once the data has been loaded, the organization will want to verify the accuracy of the data, and contact 
Lambslist should any errors be found. We allow 5 business days for the organization to review their data. If any 
corrections need to be made to the upload an additional 2-3 business days will be needed to correct the issue. 

Subsequent uploads are available, but will be subject to a $100 charge per upload. 



Data Back-up

Lambslist backs up all data nightly and stores the information at an off site location. This data can only be ac-
cessed by our senior technical engineers in the event of a data disaster recovery. Passwords are kept confi -
dential. Data is transferred to the off site location using one of two protocols, Secure FTP and/or Secure Copy.

Data Back-Up Retention 

Retention of the nightly backup data is kept for a period not longer than 6 months. After 6 months, that data 
backup is deleted. This process allows Lambslist to always have the most recent 6 months of data, month-to-
date, on fi le. Methods used to remove this data are Secure FTP and Unix scripts that automate the process of 
data retention.

Security

Lambslist uses a 256 bit encryption, is SSL Certifi ed by GoDaddy.com, and is hosted by EngineYard, a lead-
ing web hosting solution provider. With Lambslist your organization’s data will receive the same level of privacy 
and security provided by leading banking institutions. Also, we pledge that at no time will your data be sold, 
traded, or otherwise transferred to outside parties for marketing, advertising, or other uses. 

Browsers and Operating Systems

Lambslist supports the following operating systems:

Windows XP
Windows Vista
Windows 7
Mac OS 10.5.x - 10.7.x (Power PC Macs are no longer supported)

Lambslist supports the following browsers:

Windows: IE 8, IE 9, FF 3.x - FF 7.x
Mac: Safari 5.x, Chrome  (available only with Snow Leopard or Lion, using Dymo 8.3.1 software)
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FAQ’s

Q: How do we adjust the font on our labels?
A: To adjust the font on your label, follow the appropriate steps listed below based upon the OS you are using 
on the computer.

XP: Open the Dymo software, click on the File tab, then Open. Next, click on the drop down arrow in the “Look 
in:” fi eld and follow this path: Local Disk (C:)/Documents and Settings/All Users/Shared Documents/DYMO 
Label/Label Files. To open the child label click on Shipping (30323, 30573), or Address (30252, 30320, 30572) 
for the parent label. With the label open in the Dymo software, click on the ‘Designer’ tab. Finally, click on the 
label and a cursor will appear, select the area you wish to change and highlight that area. Change the font to 
the size you prefer, then click the ‘Save’ icon. 

Vista/Windows 7: Open the Dymo software, click on the File tab, then Open. Next, click on the drop down ar-
row in the “Look in:” fi eld and follow this path: Local Disk (C:)/ Users/Public/Public Documents/DYMO Label/La-
bel Files. To open the child label click on Shipping (30323, 30573), or Address (30252, 30320, 30572) for the 
parent label. With the label open in the Dymo software, click on the ‘Designer’ tab. Finally, click on the label 
and a cursor will appear, select the area you wish to change and highlight that area. Change the font to the 
size you prefer, then click the ‘Save’ icon. 

MAC OS: Follow this path to open the Dymo software: Finder/Applications/DYMO Label. Once in the software 
click on the ‘File’ tab, then ‘Open’. To open the child label click on the Shipping (30323, 30573) label with a 
printer icon in front of it, or Address (30252, 30320, 30572) with the printer icon in front of it for the parent label. 
With the label open in the Dymo software, click on the ‘Designer’ tab. Finally, click on the label and a cursor will 
appear, select the area you wish to change and highlight that area. Change the font to the size you prefer, then 
click the ‘Save’ icon.

Q: How do I add a logo to our label?
A: To add a logo to your label, follow the appropriate steps listed below based upon the OS you are using on 
the computer.

XP: Open the Dymo software, click on the File tab, then Open. Next, click on the drop down arrow in the “Look 
in:” fi eld and follow this path: Local Disk (C:)/Documents and Settings/All Users/Shared Documents/DYMO 
Label/Label Files. To open the child label click on Shipping (30323, 30573), or Address (30252, 30320, 30572) 
for the parent label. With the label open in the Dymo software, click on the ‘Designer’ tab and scroll down 
through the label objects to the ‘Image’ option. Double click on ‘Image’, then File, and fi nally the Browse button 
to locate your image. 

Vista/Windows 7: Open the Dymo software, click on the File tab, then Open. Next, click on the drop down ar-
row in the “Look in:” fi eld and follow this path: Local Disk (C:)/ Users/Public/Public Documents/DYMO Label/La-
bel Files. To open the child label click on Shipping (30323, 30573), or Address (30252, 30320, 30572) for the 
parent label. With the label open in the Dymo software, click on the ‘Designer’ tab and scroll down through the 
label objects to the ‘Image’ option. Double click on ‘Image’, then File, and fi nally the Browse button to locate 
your image. 

MAC OS: Follow this path to open the Dymo software: Finder/Applications/DYMO Label. Once in the software 
click on the ‘File’ tab, then ‘Open’. To open the child label click on the Shipping (30323, 30573) label with a 
printer icon in front of it, or Address (30252, 30320, 30572) with the printer icon in front of it for the parent label. 
With the label open in the Dymo software, click on the ‘Designer’ tab and scroll down through the label objects 
to the ‘Image’ option. Double click on ‘Image’, then File, and fi nally the Browse button to locate your image.
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Q: Do we have to use a barcode scanner to utilize the Self Check-In feature?
A: You do not have to use a barcode scanner to utilize the Self Check-In feature. You could also have the par-
ents enter their 7-digit phone number using either the keyboard or a touch screen.

Q: Why does the room fi eld display “Select A Room” when only one room is available?
A: The room fi eld will display “Select A Room” if the child has not been previously checked into the currently 
active service. Once they have been checked into a service one time, the next time they come to that service 
the system will remember the room the checked into the last time they attended this service.

Q: Why does the room fi eld say “Not Available” when I am trying to check a child in?
A: If the room fi eld says “Not Available”, the child does not fi t into any or the rooms available for that service. 
Check to make sure the room they should be in matches their age/grade/development level, and the room is 
available for that specifi c service. Make changes as needed.

Q: How do I reactivate a child/family?

A: To reactivate a deactivated/graduated family or child you will need to fi rst go to your preferences screen 
located under the Set Up tab. Mark the box next to “Show hidden and inactive records”, then click on the save 
button. Next pull the family account up as though you were going to check them into a service. Click on the text 
of their family name (ex. Smith Family) if you are reactivate an entire family, or the child’s name (ex. Chase) if 
reactivating an individual child, this will provide an ‘edit info’ box. Click on ‘edit info’ and locate the status fi eld. 
Click on the down arrow and choose “active”, then click update.

Q: How do I deactivate a child/family?

A: To deactivate a family, pull the family account up as though you were going to check them into a service. 
Next, click on the text of their family name (ex. Smith Family) ) if you are deactivating an entire family, or the 
child’s name (ex. Chase) if deactivating an individual child, this will provide an ‘edit info’ box. Click on ‘edit info’ 
and locate the status fi eld. Click on the down arrow and choose “deactivated”, then click update.

Q: How do I get my data into Lambslist?

A: Determine if the program that is storing your data can EXPORT to a .csv fi le format.
Click on the attachment on the FAQ screen called Upload_Template.xls
Format and then export your data to match the UploadTemplate.
Save the template as a .csv fi le
E-mail your attached data fi le to support@lambslist.com.

Q: Can I use FireFox to access lambslist?

A: You can use FireFox on XP, Vista and Windows 7 with the Dymo printer. Dymo does not support FireFox on 
the Mac. 

Q:Why are some of my children highlighted in color?
A: At times, when accessing a child for check-in, their name will appear highlighted in yellow, green, or red. The 
purpose for this hi lighting is to notify those checking the child in that the child’s birthday either has occurred in 
the past seven days, will occur in the next seven days, or is today. The color codes are identifi ed as follows:

 Yellow - The child’s birthday will occur in the next seven (7) days.

 Green - Today is the child’s birthday.

 Red - The child’s birthday occurred in the past seven (7) days. 
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Q: Is there a way to communicate with parents?
A: Communication with parents via e-mail and SMS text is an available option en masse, individually, or by group. The 

mass option is found by clicking on the ‘Families’ tab under Maintenance, while the individual option  is found by click-
ing on the family name on the check-in screen. Group communication can be utilized through various reports 

lambslist offers. See reports for more information.

Appendix A - Dymo Printer 

Dymo Printer Setup

Directions for setting up your Dymo printer are found by following these steps:

 1. Click on the ‘Help’ tab under ‘Set Up’
 
 2. Click on the ‘Dymo Printer Help’ icon

 3. Choose the OS that applies to your computer

 4. Follow the instructions listed.

Appendix B – Kiosk Tips and Tricks

Lambslist has been designed to effi ciently work with touch-screen and/or bar code scanning kiosk.  However, 
there are a few operating system tips that will make your kiosk experience even better.  These tips work well 
for Windows-based self check-in stations.

Level 1 - Kiosk Simulation

Once you have logged into lambslist and chosen your preferred self check-in screen, press F11 on the key-
board to hide the entire IE menu bar and controls.

Level 2 - Kiosk Control

(An IT-savvy volunteer may be needed for this.)  Internet Explorer can be started in kiosk mode by running 
from the command prompt or shortcut with the command line switch “-k.”

The command line should read “iexplore –k www.lambslist.com.”  For more detailed information on locking 
down Windows kiosk, type “windows” or “kiosk explorer” in a Google search engine.
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